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Welcome to 2015 Knowledge-Based Audits, Preparations, Compilations and Reviews™ of Common Interest Realty
Associations for ProSystem fx® Knowledge Coach

This Release Notes document provides important information about the 2015 release of Knowledge Based Audits, Preparations,
Compilations and Reviews ™ of Common Interest Realty Associations. Please review this information carefully. If you have any
questions, contact Customer Support at 1-800-PFX-9998, option 4, then option 1. Additional information is available on CCH Support
Online.

New in this Release

Knowledge-Based Audits, Preparations, Compilations and Reviews of Common Interest Realty Associations is designed to help the
auditor/practitioner efficiently and effectively perform financial statement audits, preparations, compilations and reviews of common
interest realty associations (CIRAs) in accordance with auditing standards generally accepted in the United States of America (GAAS)
and in accordance with Statements on Standards for Accounting and Review Services (SSARS) issued by the Accounting and Review
Services Committee (ARSC) of the American Institute of Certified Public Accountants (AICPA).

The Knowledge-Based Audit is a risk-based methodology that emphasizes using knowledge of the entity to make risk assessments in
connection with a financial statement audit. This allows the auditor to more appropriately focus audit efforts on those areas which in
the auditor’s judgment are the most significant and pose the most risk to the financial statement audit.

The Knowledge-Based Preparations, Compilations and Reviews (KBPCR) Methodology emphasizes using knowledge of the CIRA to
perform preparation, compilation and review engagements by facilitating the flow of information so that the understanding obtained in
each process affects the decisions made in the next. Although the accountant will likely perform most steps in this methodology
sequentially, conducting an engagement is not necessarily a linear process. Knowledge gained from preliminary engagement activities
helps the accountant design and customize engagement procedures; evidence gained from procedures performed is evaluated and the
appropriate accountant’s report is issued. This edition includes specific up-to-date guidance for conducting preparation, compilation
and review engagements of CIRAs in accordance with the SSARS.

The operations of CIRAs are often unique and complex and require specialized accounting and auditing knowledge. This edition includes
specific up-to-date guidance for performing attestation engagements of CIRAs.

Conducting audits and attestation engagements of CIRAs requires the exercise of the auditor’s professional judgment. This document is
published for the purpose of communicating, to users of the toolset, updates and enhancements included in the current version. This
document is not, and should not be used as an audit program to update the audit documentation of an engagement started in a
previous version of this product.

This is the fourth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

The 2015 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

The 2015 edition of Knowledge-Based Audits of Common Interest Realty Associations features numerous enhancements, including:

¢ Findings are accumulated in the Internal Control Documents, including KBA-401 through KBA-411, to better facilitate flow to
KBA-103

¢ Revised rule-of-thumb percentages in KBA-301. The benchmarks and related percentages are based on the judgment of our
expert authors. Our expert authors base them on issues encountered in practice, research studies, AICPA audit risk and sampling
guides, AICPA interpretive guidance (including AICPA CPE courses), and Big Firm practices and policies. Based on this


http://support.cch.com/productsupport/
http://support.cch.com/productsupport/

information, with regard to this toolset, the commonly used rule of thumb amounts were revised to 1/2-2% for total assets and
1/2-2% for total revenues.

¢ Updates to the KBA-400 series workpapers to facilitate the changes to the 2013 Internal Control-Integrated Framework ("COSO
Framework") established by the Committee of Sponsoring Organizations of the Treadway Commission AICPA's Code of
Professional Conduct-Revised
¢ Several new forms and programs are available in this title including:
o AID-603 Component Identification and Analysis
o AID-835 Board Minutes Review Checklist
o AUD-908 Interim Review Program: Management Inquiries
The 2015 edition of Knowledge-Based Preparations, Compilations and Reviews of Common Interest Realty Associations features
numerous enhancements, including:

¢ New Knowledge-Based Preparation Title package to address the requirements of SSARS No. 21 to enable the practitioner to
perform an efficient preparation engagement in compliance with standards. New documents in the new Preparation title
include:

PRP-101 Overall Preparation Program

PRP-201 Pre-Preparation Program: Procedures Performed Prior to a Preparation Engagement
PRP-202 Preparation Program: Additional Procedures for Initial Year of Engagement
PRP-801 Preparation Program: Significant Risks and Uncertainties

PRP-901 Preparation Program: Discovery of Facts after the Completion of the Engagement
PRP-902 Preparation Program: Going Concern

KBP-101 Preparation: Significant Matters

KBP-201 Preparation: Client/Engagement Acceptance and Continuance Form

KBP-901 Preparation: Documentation Checklist

KBP-902 Preparation: Review and Approval Checklist

RPT-0999 Disclaimer to Accompany Prepared Financial Statements

O 0 O O O O O O O O O O

COR-203 Engagement Letter: Preparation of Financial Statements

¢ The Compilation and Review workpapers have been modified to address the requirements of SSARS No. 21 including new and
modified practice points, procedures steps and reports.

For more information on specific program enhancements, review the 2015 CIRA Overviews for Knowledge Coach Users available at the
following link or in the binder through the KCO-001 workpaper.
Audits :

http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20CIRA%20Audit%20Title%200verview%20for%20Knowle
dge%20Coach%20Users.pdf

Preparations, Compilations, and Reviews:

http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20CIRA%20Preparations,%20Compilations,%20and%20Revi
ews%20Title%200verview%20for%20Knowledge%20Coach%20Users.pdf

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:

New literature, standards, and developments, reflected in the following current audit and accounting guidance:
¢ AU-C930, Interim Financial Information

¢ AICPA Statement on Quality Control Standards No. 8 (SQSC-8), A Firm's System of Quality Control (Redrafted)


http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20CIRA%20Audit%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20CIRA%20Audit%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20CIRA%20Preparations,%20Compilations,%20and%20Reviews%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20CIRA%20Preparations,%20Compilations,%20and%20Reviews%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
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¢
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2013 Internal Control-Integrated Framework (Framework) established by the Committee of Sponsoring Organizations of the
Treadway Commission AICPA’s Code of Professional Conduct—Revised
FASB Accounting Standards Codification as of June 30, 2015, and through Accounting Standards Update No. 2015-10, including

o ASU No. 2015-03, Interest—mputation of Interest (Subtopic 835-30): Simplifying the Presentation of Debt Issuance
Costs;

o ASU No. 2015-04, Compensation—Retirement Benefits (Topic 715): Practical Expedient for the Measurement Date of
an Employer’s Defined Benefit Obligation and Plan Assets;

o ASU No. 2015-05, Intangibles—Goodwill and Other—nternal-Use Software (Subtopic 350-40): Customer’s
Accounting for Fees Paid in a Cloud Computing Arrangement;

o ASU No. 2015-06, Earnings Per Share (Topic 260): Effects on Historical Earnings per Unit of Master Limited
Partnership Dropdown Transactions;

o ASU No. 2015-07, Fair Value Measurement (Topic 820): Disclosures for Investments in Certain Entities That Calculate
Net Asset Value per Share (or Its Equivalent);

o ASU No. 2015-08, Business Combinations (Topic 805): Pushdown Accounting — Amendments to SEC Paragraphs
Pursuant to Staff Accounting Bulletin No. 115;

o ASU No. 2015-09, Financial Services—nsurance (Topic 944): Disclosures about Short-Duration Contracts; and
o ASU No. 2015-10, Technical Corrections and Improvements.

Statement on Standards for Accounting and Review Services No. 21 (SSARS No. 21), Clarification and Recodification (including
AR-C Section 60, General Principles for Engagements Performed in Accordance with Statements on Standards for Accounting
and Review Service; AR Section 80, Compilation Engagements; AR Section 90, Review of Financial Statements);

2014/2015 Audit Risk Alert Developments in Review, Compilation, and Financial Statement Preparation Engagements—2014/15;
Nonattest Services interpretation (ET Section 101.05, and 191-.015-016; as of December 15, 2014, ET Section 1.295); and
AICPA Code of Professional Conduct (Code)

Additional Information on Knowledge Coach and the KBA Methodology

Knowledge-Based Audit (KBA) Methodology - Allows the results of one set of procedures to become the input for the next. The key
components of the KBA methodology include:

¢
¢

An Overview that guides auditors through the methodology;

Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by GAAS;

Customizable Audit Programs that take auditors through related steps and procedures;

Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit
Programs;

Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements; and

Correspondence documents that provide sample letters to be used to comply with GAAS requirements and in many other
common situations.

The AICPA’s Auditing Standards Board's (ASB) Risk Assessment Standards - The practice aids and tools in the 2015 Knowledge-
Based Audits of CIRAs are designed around the AICPA’s risk assessment and clarified standards to assist auditors of nonpublic
CIRAs by:

e  Facilitating compliance with GAAS;
e Encouraging more effective audits through tailored audit programs and comprehensive practice aids;
e Helping auditors to focus on and respond to identified audit risks; and

e Enhancing audit documentation.



Knowledge-Based Preparation, Compilation and Review (KBPCR) Methodology - Allows the results of one set of procedures to become
the input for the next. The key components of the KBPCR methodology include:

¢
¢

An Overview that guides practitioners through the methodology;

CIRA Preparation Programs, Compilation Programs and Review Programs that take accountants through related steps and
procedures designed for use in compilation and review engagements;

Practice Aids to help accountants complete steps or processes outlined in other related documents and provide example
financial statement formats for different types of entities;

Reports that provide a variety of sample accountant’s reports on compiled or reviewed financial statements;

Correspondence documents that provide sample engagement letters and management representation letters to be used in
many common situations; and

Knowledge-Based Preparation, Compilation and Review documents, integral to the overall engagement process, that contain
steps and procedures required by SSARSs.

The AICPA’s Accounting and Review Services Committee (ARSC) SSARS - The practice aids and tools in the 2015 Edition of Knowledge-
Based Preparations, Compilations and Reviews of Common Interest Realty Associations are designed around the AICPA’s SSARS
standards to assist accountants by:

¢
¢
¢

Facilitating compliance with the SSARS;
Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids; and

Enhancing engagement documentation.

ProSystem fx® Knowledge Coach

¢

ProSystem fx® Knowledge Coach functionality allows auditors/accountants to use the KBA or KBPCR based methodology more
efficiently by eliminating the need for duplicate entry of the same information, tailoring documentation to each particular
engagement, and documenting the link between risks identified and procedures performed. AUD-100 Tailoring Question, PRP-
100 Tailoring Question Workpaper, CMP-100 Tailoring Question Workpaper or REV-100 Tailoring Question Workpaper is a
document in Knowledge Coach that presents engagement-level questions designed to aid in tailoring the engagement
documentation to fit each client. Completing the questions helps the auditor/accountant avoid duplication and unnecessary
workpapers.

Before you begin your audit, preparation, compilation or review, please review the guidance in AUD-101 Overall Audit Program,
PRP-101 Overall Preparation Program, CMP-101 Overall Compilation Program or REV-101 Overall Review Program. These
workpapers are intended to be your road map through a KBA and/or KBPCR methodology. You should start your audit,
preparation, compilation or review with AUD-100 Tailoring Question, PRP-101 Overall Preparation Program, CMP-100 Tailoring
Question Workpaper or REV-100 Tailoring Question Workpaper and AUD-101 Overall Audit Program, CMP-101 Overall
Compilation Program or REV-101 Overall Review.

In the Audit title only, risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the
current editor of KBA-502 Summary of Risk Assessments. This allows the user to continuously assess risks during the
engagement. Several workpapers prompt the consideration of the presence of risks, but the Risk Summary task pane must be
used to document those risks. All documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure
to check the “workpaper identified in” field of the Risk pane.

The Risk Assessment features have been disabled for the 2015 Knowledge-Based Preparations, Compilations and Review Title for
Knowledge Coach. Refer to KBP-101 Preparation: Significant Matters, KBC-101 Compilation: Significant Matters and KBR-102
Review: Significant Matters to accumulate and review significant issues and findings. PRP-801 Preparation Program, CMP-801
Compilation Program: Significant Risks and Uncertainties and REV-802 Review Program: Significant Risks and Uncertainties
provides a guide for implementing the guidance related to the disclosure of certain significant risks and uncertainties.

Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit/engagement file.



¢ Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

¢ Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit, preparation, compilation
and review content, you can link directly to source material from Resources within Knowledge Coach workpapers. These links
have been updated to reference to the accounting standards under the FASB Accounting Standards Codifications and the
auditing standards issued by the AICPA. Also, if you subscribe to the Knowledge-Based Audits, Preparations, Compilations and
Reviews of CIRAs Guide on ARM, you can take advantage of links to the audit, preparation, compilation and review guide
material from within the Knowledge Coach documents.

¢ Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors/accountants
work more effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s
Accounting Research Manager and industry audit guides by simply clicking on the Reference.

Important Notes
¢ Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

¢ If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
o Keep the binder with the affected workpapers open.
o Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.
¢ Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach

workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central file
room and through peer-to-peer sync in the same way other Engagement workpapers are shared.

System Requirements

¢ This title MUST be used with ProSystem fx ® Engagement version 7.1, ProSystem fx® Knowledge Coach version 2.1, and 2014
Financial Statement Base v4 and higher. If you are upgrading from ProSystem fx® Engagement 7.0 or lower please contact
Technical Support at 1-800-PFX-9998, option 4 for detailed instructions.

¢ Aminimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions

Download the 2015 Knowledge Based Audits, Preparations, Compilations and Reviews of CIRAs from the ProSystem fx ®Knowledge
Coach Updates section of the ProSystem fx® Engagement Support Web site at the following URL:
http://support.cch.com/updates/KnowledgeCoach, then select the Knowledge Coach Series (Audit, Preparation, Compilation or Review)
and Download file link next to each individual title of the 2015 Knowledge-Based Audits, Preparation, Compilations and Reviews of
CIRAs series. On some occasions the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please
change the extension of the downloaded file to KCP using all capital letters.

You must install the 2014 Financial Statement Base v4 title before installing the 2015 Knowledge Based Audits, Preparations,
Compilations and Reviews of CIRAs.

The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach

If you have already installed this title for 2014 Knowledge-Based Audits of Commercial Entities, ensure you have the latest Knowledge
Coach Content Update installed.

Important: ProSystem fx® Engagement version 7.1 or higher and Knowledge Coach version 2.1 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2007, Microsoft® Office 2007 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).

The 2015 Knowledge-Based CIRAs (8/xx/15). KCP download is a proprietary file that must be installed from within Engagement. Save
this KCP file to a location on your local drive and follow the Installation Instructions included in the Release Bulletin.


http://support.cch.com/updates/KnowledgeCoach
http://support.cch.com/updates/KnowledgeCoach

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.

After downloading the 2015 Knowledge Based Audits, Preparations, Compilations and Reviews of CIRAs, do the following:

¢ Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

¢ The Knowledge Coach Titles window will be displayed.
¢ Choose Add Title.

¢ Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

¢ Choose Open.

¢ The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease”
previous versions of the title.

To unrelease a title:
¢ Select a version of the Knowledge Based CIRAs titles.
¢ Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the staff group
property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:
¢ Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
¢ Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”

Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.

Important: Once the 2015 Knowledge-Based CIRA titles have been added and released, they will be automatically deployed to other
staff members when they login to the “Office” location, or when they synchronize a binder that contains Knowledge Coach workpapers
from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.1 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2015
Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs.

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to
https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/, clicking the Firm Administration link, and making the
appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 4.
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Accounting Research Manager

CCH'’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus guidance
from financial reporting experts.

Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts
attend critical, standard-setting meetings and summarize the results for you, which means you'll learn of newly released literature and
deliberations of current financial reporting projects as soon as they occur! Plus, you'll benefit from their easy-to-understand technical
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.

Also available in the Knowledge-Based CIRAs title, a guide that helps you comply with the most recent professional standards and
guidance for the conduct of compilations and reviews and to integrate the use of practice aids, tools, and other resources with its
guidance. This publication supplements and complements the Knowledge-Based documents that are available in Knowledge Coach.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.

Reference to Accounting Research Manager (ARM) — If you subscribe to an ARM library that includes CIRA content, you can link directly
to source material from Resources within Knowledge Coach documents. These links have been updated to refer to the accounting
standards under the FASB Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based CIRAs Guide on ARM, you
can take advantage of references to the guide material from within the Knowledge Coach documents.


http://www.accountingresearchmanager.com/

Using Your Knowledge Coach Content

To use your Knowledge Coach Workpaper Templates, open a
binder in ProSystem fx® Engagement, select the workpaper
tab into which you would like to insert the workpaper, and
select New Knowledge Coach Workpaper from the toolbar
or File menu. The New Knowledge Coach Workpaper dialog
appears (Figure 1).

Select the New Knowledge Coach Title with the content you
would like to use. You can only select titles you have
installed. The information displayed changes to reflect the
workpaper organization available for the selected title.
Select the Knowledge Coach Workpaper Templates to insert
into your binder and click OK. The Selected Workpaper
Properties dialog appears. Each workpaper name is
automatically loaded into the Name field. Add a workpaper
index in the Index field and make any Name modifications
you desire. You can also modify the tab location or the roll
forward settings for each workpaper. Then click OK. The
integrated Knowledge Coach workpaper is now inserted into
your engagement binder. For more information on how to
use Knowledge Coach workpapers in your binder, see the
Knowledge Coach User Guide.

Mew Knowledge Coach Workpaper

Industry:| 2015 KBA CIRA Audits A -I-?E -TE

[[] Add Independent \Workpapers without Foundation \Workpapers

D D00-Resources Details of selected workpaper
-] 100-The Communications Hub

D 200-Pre-Engagement Procedures

: ] 3D0-Risk Assessment-Understanding the CIRA & Environmert
.D A00-Risk Assessment-Design of Intemal Controls

[]  5D0-Assessing Risk of Material Misstatement Highlight 3 workpaper or select
1 600-Audit Procedures-Response to Assessed Risks a workpaper check box to see
[ 700-Audit Procedures-Tests of Intemal Controls details.

I 800-Audit Procedures-Substartive Tests

7] 300-Evaluating, Concluding & Reporting Procedures

Cancel Help

Figure 1 - New Knowledge Coach Workpaper

2015 Knowledge-Based Audits of CIRAs, 2015 Knowledge-Based
Download Preparations of CIRAs, 2015 Knowledge-Based Compilations of
Description:  |CIRAs and/or 2015 Knowledge-Based Reviews of

CIRAs(8/10/2015)

Version:

Engagement v. 7.1 with Knowledge Coach 2.1 or higher and 2014

Financial Statement Base v4

Release Date: |August 2015

File size: 18MB

Approx.

Download 42 minutes at 56 kbps

Time:

License: Full Version

Platforms: Windows® 7, 8 and 8.1

Office: Microsoft® Office 2007 required



Contact Information

¢ For ademo or to purchase additional titles as they become available 1-800-PFX-9998, option 1

¢ Technical Support 1-800-PFX-9998, option 4, then option 1

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.
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